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Documentation Conventions MVI User Guide for IT Guru
Documentation Conventions

OPNET documentation uses specific formatting and typographic conventions to present 
the following types of information:

• Objects, examples, and system I/O

• Object hierarchies, notes, and warnings

• Computer commands

• Lists and procedures

Objects, Examples, and System I/O

• Directory paths and file names are in plain Courier typeface:

opnet\release\models\std\ip

• Function names in body text are in italics:

op_dist_outcome()

• The names of functions of interest in example code are in bolded Courier 
typeface:

/* determine the object ID of packet’s creation module */
src_mod_objid = op_pk_creation_mod_get (pkptr);

• Variables are enclosed in angle brackets (< >):

<opnet_user_home>/op_admin/err_log

Object Hierarchies, Notes, and Warnings

Menu hierarchies are indicated by right angle brackets (>); for example:

Open File > Print Setup > Properties...

Attribute hierarchies are represented by angled arrows (➘ ) that indicate that you must 
drill down to a lower level of the hierarchy:
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Attribute level 1 ➘ Attribute level 2 ➘ Attribute level 3

Note—Notes are indicated by text with the word Note at the beginning of the 
paragraph. Notes advise you of important supplementary information.

WARNING—Warnings are indicated by text with the word WARNING at the 
beginning of the paragraph. Warnings advise you of vital information about an 
operation or system behavior.

Computer Commands

These conventions apply to Windows systems and navigation methods that use the 
standard graphical-user-interface (GUI) terminology such as click, drag, and dialog box.

• Key combinations appear in the form “press <button>+x”; this means press 
the <button> and x keys at the same time to do the operation.

• The mouse operations left-click (or click) and right-click indicate that you 
should press the left mouse button or right mouse button, respectively.

Lists and Procedures

Information is often itemized in bulleted (unordered) or numbered (ordered) lists:

• In bulleted lists, the sequence of items is not important.

• In numbered lists, the sequence of items is important.

Procedures are contained within procedure headings and footings that indicate the start 
and end of the procedure. Each step of a procedure is numbered to indicate the 
sequence in which you should do the steps. A step may be followed by a description of 
the results of that step; such descriptions are preceded by an arrow.

Procedure FM-1 Sample Procedure Format 

1 Procedure step.

➥ Result of the procedure step.

2 Procedure step.

End of Procedure FM-1

For more information about using and maintaining OPNET documentation, see the 
Documentation Guide.
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Document Revision History

Release Date
Product 
Version Chapter Description of Change

August 2005 11.5 Importing 
Topologies

• Revised Procedure 2-2 Importing a Topology from Device 
Configuration Files on page MVI-2-20 to reflect changes in 
dialog box.

• Added Importing Cisco 6500 Multi-Layer Switches with Dual 
MSFCs on page MVI-2-9.

• Updated Table 2-2 to reflect new show commands and support 
for Dual MSFCs.

• Added section on Network Clouds on page MVI-2-18.

• Added section on Inferring Layer-3 IP Clouds on 
page MVI-2-14; updated related troubleshooting section and 
preference Procedure A-6.

February 2005 11.0 PL3 Overview • Changed references from “Device/Link Baseline Loads” to 
“Baseline Loads”.

November 2004 11.0 PL1 Importing 
Topologies

• Split some procedures out into Appendix A. 

• Re-organized chapter.

• Updated figures.

• Supported Commands moved to spreadsheet on Support 
Center website.

August 2004 11.0 Overview • Added Preferences on page MVI-1-3 preference.

Importing 
Topologies

• Added information about aggregate interfaces, and Frame 
Relay/ATM PVCs to Device Configuration Imports (DCI) on 
page MVI-2-2.

• Added section on Viewing the Import Summary Report on 
page MVI-2-27 .

• Modified and relocated flowcharts in Figure A-1 How DCI 
Determines the File Type of Cisco Configuration Files on 
page MVI-A-1 on page MVI-2-4and Figure A-2 How DCI 
Determines the Type of Cisco IOS File on page MVI-A-2 on 
page MVI-2-5

• Added section on new preference Performing an Import with 
DCI on page MVI-2-19.
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• Removed information about direct import from Concord 
eHealth

• Expanded coverage and procedure descriptions in Creating 
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1 Overview

The Multi-Vendor Import (MVI) module extends the built-in traffic and topology 
import features of IT Guru with capabilities that include:

• Importing traffic flows from cflowd, NetScout nGenius, Sniffer and other 
programs

• Importing baseline (link/PVC/device) load data from Concord 
NetworkHealth, InfoVista, and MRTG

• Importing distributions from packet trace files such as ExpertSniffer
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Multi-Vendor Import Menu

The following table summarizes the operations added to IT Guru by the MVI 
module and provides a reference to additional details about each operation.

Table 1-1   Multi-Vendor Import Operations

Menu item Description Reference

Topology > Import Topology >

From Device Configurations... Import a network topology from device 
configuration files

Device Configuration Imports 
(DCI) on page MVI-2-2

Traffic > Import Traffic Flows >

From cflowd... Import traffic flows from cflowd Creating cflowd Data on 
page MVI-3-8

From NAI Distributed Sniffer/Sniffer Pro Import traffic flows from Sniffer Creating Distributed 
Sniffer/Sniffer Pro Data on 
page MVI-3-2

From Cisco NetFlow... Import traffic flows from Cisco’s NetFlow Creating NetFlow Collector 
Data on page MVI-3-3

From NetScout nGenius... Import traffic flows from NetScout nGenius Configuring NetScout nGenius 
and IT Guru on page MVI-3-9

Traffic > Import Baseline Loads >

From Concord NetworkHealth... Import baseline load traffic from Concord 
NetworkHealth data files and databases

Concord eHealth Baseline 
Loads: Preparing for an Import 
on page MVI-4-9

From MRTG... Import link load traffic from Multi-Router 
Traffic Grapher (MRTG) data files

Creating MRTG Log Files on 
page MVI-4-2

From InfoVista... Import link load traffic from InfoVista 
reports

InfoVista Link Loads: Preparing 
for an Import on page MVI-4-4

End of Table 1-1
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Preferences

The MVI module adds the following preferences to IT Guru.

bgutil_hp_ov_perf_insight_bucket_size

Specifies the bucket size to be used for HP OV Performance Insight imports. 
This preference can be set also from the Import Link Baseline Loads from HP 
OpenView Performance Insight FIles dialog box.

bgutil_hp_ov_perf_insight_bucket_type

Specifies the bucket mode to be used for HP OV Performance Insight imports. 
This preference can be set also from the Import Link Baseline Loads from HP 
OpenView Performance Insight FIles dialog box.

bgutil_hp_ov_perf_insight_file_list

Specifies a list of files to be imported as HP OV Performance Insight files. This 
preference can be set also from the Import Link Baseline Loads from HP 
OpenView Performance Insight FIles dialog box.

bgutil_hp_ov_perf_insight_from_time

Specifies the start of the time window for filtering HP OV Performance Insight 
data. This preference can be set also from the Import Link Baseline Loads from 
HP OpenView Performance Insight FIles dialog box.

Type string

Default Value “As Is”

Type string

Default Value “Average”

Type string list

Default Value <empty>

Type string

Default Value “ALL VALUES”
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bgutil_hp_ov_perf_insight_overwrite

Specifies whether HP OV Performance Insight imports should overwrite existing 
data. When TRUE, existing data is overwritten. This preference can be set also 
from the Import Link Baseline Loads from HP OpenView Performance Insight 
FIles dialog box.

bgutil_hp_ov_perf_insight_to_time

Specifies the end of the time window for filtering HP OV Performance Insight 
data. This preference can be set also from the Import Link Baseline Loads from 
HP OpenView Performance Insight FIles dialog box.

bgutil_infovista_bucket_size

Specifies the bucket size to be used for InfoVista imports. This preference can 
be set also from the Import Link Baseline Loads from InfoVista Reports dialog 
box.

bgutil_infovista_bucket_type

Specifies the bucket mode to be used for InfoVista imports. This preference can 
be set also from the Import Link Baseline Loads from InfoVista Reports dialog 
box.

Type boolean

Default Value TRUE

Type string

Default Value “ALL VALUES”

Type string

Default Value “As Is”

Type string

Default Value “Average”
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bgutil_infovista_file_list

Specifies a list of files to be imported as InfoVista files. This preference can be 
set also from the Import Link Baseline Loads from InfoVista Reports dialog box.

bgutil_infovista_from_time

Specifies the start of the time window for filtering InfoVista data. This preference 
can be set also from the Import Link Baseline Loads from InfoVista Reports 
dialog box.

bgutil_infovista_overwrite

Specifies whether InfoVista imports should overwrite existing data. When 
TRUE, existing data is overwritten. This preference can be set also from the 
Import Link Baseline Loads from InfoVista Reports dialog box.

bgutil_infovista_to_time

Specifies the end of the time window for filtering InfoVista data. This preference 
can be set also from the Import Link Baseline Loads from InfoVista Reports 
dialog box.

bgutil_mrtg_bucket_size

Specifies the bucket size to be used for MRTG imports. This preference can be 
set also from the Import Link Baseline Loads from MRTG Log FIles dialog box.

Type string list

Default Value <empty>

Type string

Default Value “ALL VALUES”

Type boolean

Default Value TRUE

Type string

Default Value “ALL VALUES”

Type string

Default Value “As Is”
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bgutil_mrtg_bucket_type

Specifies the bucket mode to be used for MRTG imports. This preference can 
be set also from the Import Link Baseline Loads from MRTG Log FIles dialog 
box.

bgutil_mrtg_file_list

Specifies a list of files to be imported as MRTG files. This preference can be set 
also from the Import Link Baseline Loads from MRTG Log FIles dialog box.

bgutil_mrtg_from_time

Specifies the start of the time window for filtering MRTG data. This preference 
can be set also from the Import Link Baseline Loads from MRTG Log FIles 
dialog box.

bgutil_mrtg_overwrite

Specifies whether MRTG imports should overwrite existing data. When TRUE, 
existing data is overwritten. This preference can be set also from the Import Link 
Baseline Loads from MRTG Log FIles dialog box.

Type string

Default Value “Average”

Type string list

Default Value <empty>

Type string

Default Value “”

Type boolean

Default Value TRUE
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bgutil_mrtg_to_time

Specifies the end of the time window for filtering MRTG data. This preference 
can be set also from the Import Link Baseline Loads from MRTG Log FIles 
dialog box.

bgutil_nethealth_file_alias

Specifies whether Networkhealth file imports should import alias files as well as 
data files. When TRUE, both are imported. This preference can be set also from 
the Import Link Baseline Loads from eHealth-Network Data FIles dialog box.

bgutil_nethealth_file_alias_file

Specifies a Networkhealth alias file to import. This preference can be set also 
from the Import Link Baseline Loads from eHealth-Network Data FIles dialog 
box.

bgutil_nethealth_file_bucket_size

Specifies the bucket size to be used for Networkhealth imports. This preference 
can be set also from the Import Link Baseline Loads from eHealth-Network Data 
FIles dialog box.

Type string

Default Value “”

Type boolean

Default Value TRUE

Type string

Default Value “As Is”

Type string

Default Value “As Is”
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bgutil_nethealth_file_bucket_type

Specifies the bucket mode to be used for Networkhealth imports. This 
preference can be set also from the Import Link Baseline Loads from 
eHealth-Network Data FIles dialog box.

bgutil_nethealth_file_file_list

Specifies a list of files to be imported as Networkhealth files. This preference 
can be set also from the Import Link Baseline Loads from eHealth-Network Data 
FIles dialog box.

bgutil_nethealth_file_from_time

Specifies the start of the time window for filtering Networkhealth data. This 
preference can be set also from the Import Link Baseline Loads from 
eHealth-Network Data FIles dialog box.

bgutil_nethealth_file_overwrite

Specifies whether Networkhealth imports should overwrite existing data. When 
TRUE, existing data is overwritten. This preference can be set also from the 
Import Link Baseline Loads from eHealth-Network Data FIles dialog box.

Type string

Default Value “Average”

Type string list

Default Value <empty>

Type string

Default Value “ALL VALUES”

Type boolean

Default Value TRUE
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bgutil_nethealth_file_to_time

Specifies the end of the time window for filtering Networkhealth data. This 
preference can be set also from the Import Link Baseline Loads from 
eHealth-Network Data FIles dialog box.

device_import.create_ebgp_node

Specifies whether external AS Ebgp peers can be created after import. When 
TRUE, creation of peers is enabled.

When changed from the Preferences dialog box, the value of this preference 
does not change until startup. However, changes made in the Import Device 
Configurations dialog box are saved to this preference after each import.

device_import.create_edge_lans

Specifies whether Edge LANs can be created during import. When TRUE, 
creation of Edge LANs is enabled.

When changed from the Preferences dialog box, the value of this preference 
does not change until startup. However, changes made in the Import Device 
Configurations dialog box are saved to this preference after each import.

device_import.create_pvc

Specifies whether to create ATM or Frame Relay PVCs based on network data 
or to create a full mesh between all possible pairs of devices in the network. This 
attribute can only be changed at startup.

Type string

Default Value “ALL VALUES”

Type boolean

Default Value FALSE

Type boolean

Default Value FALSE
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When changed from the Preferences dialog box, the value of this preference 
does not change until startup. However, changes made in the Import Device 
Configurations dialog box are saved to this preference after each import.

device_import.logging

Specifies whether skipped lines and the information contained in device 
descriptions should be logged. When TRUE, such logging is enabled.

When changed from the Preferences dialog box, the value of this preference 
does not change until startup. However, changes made in the Import Device 
Configurations dialog box are saved to this preference after each import.

network_health.path

Specifies the full path name of the local directory in which NetworkHealth 
executable files reside. OPNET looks in this directory when you import from a 
NetworkHealth database.

ngenius_servers

Specifies a list of available servers (that is, hostnames or IP addresses) that 
have NetScout nGenius installed. OPNET looks at these servers for NetScout 
nGenius databases during a traffic import. 

Type boolean

Default Value TRUE

Type boolean

Default Value FALSE

Type string list

Default Value “”

Type string

Default Value “”
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2 Importing Topologies

With the MVI module, you can import network topologies from the following 
sources:

This chapter describes how to import from each of these sources. IT Guru can 
import network topologies from other sources also, but only the imports that 
require the MVI module are described here. For information about topology 
imports that do not require the MVI module, refer to Chapter 10 Importing 
Network Topologies on page ITU-10-1 of the Guru User Guide. 

Note—Procedures relating directly to MVI are contained within the body of this 
chapter. For information on how MVI parses the configuration data and how to 
gather the data for the import, see App A Additional DCI Procedures on 
page MVI-A-1.

Table 2-1   Topology Imports that Use the MVI Module

File Format / Program Reference

Router and switch 
configuration data

Device Configuration Imports (DCI) on page MVI-2-2

End of Table 2-1
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Device Configuration Imports (DCI)

DCI lets you generate a network model by importing configuration data for

• Juniper routers

• Cisco routers

• Cisco PIX devices

• Cisco Catalyst switches

DCI uses the data in the configuration files to set the IT Guru attributes that 
control routing and switching behavior, including

• Connections, data rates, and interfaces (including PVCs, aggregate 
interfaces, loopback interfaces, tunnel interfaces, VLANs, and 
sub-interfaces)

• Protocol information for IP, IP Multicast, BGP, EIGRP, OSPF, RIP (versions 
1 and 2), IS-IS, MPLS, IGRP, IPX, Frame Relay, ATM, RSRB, DLSW, NAT, 
QoS, and VPLS

• ACLs (access control lists), route maps, and Juniper firewall filters

• Static routing, default routing, policy routing, and route redistribution

• VLAN, spanning tree, and bridge configuration information

• Cisco security: AAA, TACACS+, Radius, Kerberos

Supported Commands and Features

During import, OPNET considers and parses device configurations and 
translates these into model attributes. Currently, not all specific configuration 
commands and values are supported. For information on the commands and 
features that are supported, see the OPNET Support Center website.

General Workflow

The general workflow to generate a topology is as follows:

1) Create the device configuration files for the routers, Cisco PIX devices, and 
switches you want to import.

2) Import the device configurations into IT Guru.

3) Specify missing interface, port, or link information such as data rate and 
unnumbered interface information. DCI includes an Import Assistant for you 
to specify this information. To see more about this feature, refer to Using 
the Import Assistant on page MVI-2-23.
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To include supplemental information that is not in the configuration files, you can 
apply model assistant files during or after the import. For more information on 
Model Assistant files, refer to Model Assistant on page ITU-6-50. You can also 
do a partial or incremental import to add new devices to the topology or to 
update devices already in the topology.

After the network is generated and fully configured, you can run simulation 
studies, using discrete event or flow analysis, or validation studies using 
NetDoctor.

The following references point to sections of this document that describe each 
step in detail.

• Preparing for the Import: 

— Includes directory and file creation, creating device models, and setting 
import preferences

• Troubleshooting the Import

— Includes information on common import issues and how to avoid them

• Performing an Import with DCI

• Using the Import Assistant

— Connecting Unnumbered Interfaces

— Specifying Data Rates

• Viewing the Import Summary Report

• Using Model Assistant Files with Imported Topologies

• After the Import

— Includes information about generating reports and managing the network 
model

Preparing for the Import

This section introduces the pre-import workflow, including preferences, caveats, 
and troubleshooting tips that are helpful for preparation before you import your 
device files. Paying careful attention when planning for an import can help 
reduce post-import issues.

There are two basic pre-import steps:

• Create directories that are accessible to IT Guru for the configuration files

• Obtain configuration files for the devices you want to import
IT Guru/Release 11.5 MVI-2-3



2—Importing Topologies MVI User Guide for IT Guru
Creating the Configuration Files

Before importing configuration files into IT Guru, you must first generate the files 
from the configuration information on each device. The configuration files are 
created by running a few commands, which are listed in Table 2-2, on the router 
or switch and copying the output to a text file, as shown in Figure 2-1. To see 
the procedures for collecting the device configuration files, refer to the 
procedures in App A Additional DCI Procedures on page MVI-A-1.

Table 2-2   Show Commands Used by DCI

Command Importance Usefulness

show running-config Required for Cisco routers 
and PIX devices

The output from this command carries the basic 
information about the Cisco router, PIX firewall, or IOS 
device, interfaces, and configuration.

show configuration Required for Juniper 
routers

The output from this command carries the basic 
information about the Juniper device, interfaces, and 
configuration.

show config all Required for Cisco 
Catalyst Switches

The output from this command carries the basic 
information about the Cisco Catalyst switch configuration.

show version1 Optional but 
recommended.

DCI uses the output from this command to determine the 
type of device from which it was collected. 

show cdp neighbors detail Required for Cisco 
switches; Optional for 
Cisco routers

DCI uses the output from this command to determine 
connectivity between neighboring devices.

show vlan Required for Cisco 
switches running IOS and 
CatOS.

DCI uses the output from this command to determine the 
supported VLANs on the device.

show frame-relay map Required to replicate static 
Frame Relay PVCs in 
model

DCI uses the output from this command to create Frame 
Relay PVCs in the network model.

show atm map Required to replicate static 
ATM PVCs in model

DCI uses the output from this command to create ATM 
pvcs in the network model.

show ip route Required to create routing 
tables for devices in model

DCI uses the output from this command to create routing 
tables that can be used during simulations. (NOTE: Must 
be placed at end of configuration file).
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Multi-Layer Switches with Dual MSFC

show module Required on switches with 
Native IOS and on 
supervisor engine for 
switches with Hybrid OS

DCI uses the output from this command to determine the 
presence and serial numbers of MSFCs.

show version Required on supervisor 
engine and MSFC(s) for 
switches with Hybrid OS

DCI uses the serial number from the output of this 
command to correlate the MSFCs to the switch.

show redundancy Required on MSFC(s) for 
switches with Hybrid OS

DCI uses the output from this command to determine 
which of two MSFCs is designated.

End of Table 2-2
1.Show version is now supported for PIX firewall.

Table 2-2   Show Commands Used by DCI

Command Importance Usefulness
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Figure 2-1   Creating Device Configuration Files

Router_D>
Router_D>enable
Router_D#
Router_D#show running-config
Building configuration...

Current configuration: 627 bytes
!
version 12.2
service timestamps debug datetime msec
service timestamps log datetime msec
no service password-encryption
!
hostname “Router_D”
!
!
ip subnet-zero
!
!
policy-map rho
!
!
interface Tunnel0
no ip address
!
interface Ethernet0

Router_D#show version
Cisco Internetwork Operating System Software
IOS (tm) 2500 Software (C2500-IS-L), Version 12.2(13)T, RELEASE SOFTWARE (fc1)
TAC Support: http://www.cisco.com/tac
Copyright (c) 1986-2002 by cisco Systems, Inc.
Compiled Sat 16-Nov-02 07:47 by ccai
Image text-base: 0x0307A6E8, data-base: 0x00001000
ROM: System Bootstrap, Version 11.0(10c)XB2, PLATFORM SPECIFIC RELEASE SOFTWARE
(fc1)
BOOTLDR: 3000 Bootstrap Software (IGS-BOOT-R), Version 11.0(10c)XB2, PLATFORM SP
ECIFIC RELEASE SOFTWARE (fc1)

Router_D uptime is 2 weeks, 3 days, 1 hour, 51 minutes
System returned to ROM by power-on
System image file is “flash:/c2500-is-l.122-13.T.bin”

cisco 2500 (68030) processor (revision L) with 14336K/2048K bytes of memory.
Processor board ID 21583630, with hardware revision 00000000
Bridging software.
X.25 software, Version 3.0.0.
2 Ethernet/IEEE 802.3 interface(s)
2 Serial network interface(s)
32K bytes of non-volatile configuration memory.

Router_D#show cdp neighbors detail

Capability Codes: R - Router, T - Trans Bridge, B - Source Route Bridge

                  S - Switch, H - Host, I - IGMP, r - Repeater

Device ID        Local Intrfce     Holdtme    Capability Platform Port ID

Router_D#
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Creating Device Models (Optional)

During the import, DCI searches the model directories for the device model that 
best matches each configuration file. Typically, this model has more interfaces 
or ports than the actual device. You can create a set of device models with the 
same number and type of interfaces as the devices you are importing. Doing this 
ensures that the models chosen during import match the actual routers or 
switches exactly. 

You can use the Device Creator to create these models, as described in 
Creating Custom Models with Device Creator on page ITU-6-73 of the Guru 
User Guide. This step is optional, but it gives you the greatest control over the 
devices chosen by DCI to represent the imported devices.

Importing Multi-Layer Switch Configurations

In preparation for any device configuration import, you must be sure to gather 
all the device configuration files necessary to build an accurate topology. It is 
default DCI behavior to skip a device for which a partial configuration is found. 
For import of a Layer-3 switch, two device configuration files are required. 

Figure 2-2   Configuration Files Required for Multi-Layer Switch
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After import, the files create one device in the network model, as shown in 
Figure 2-3.

Figure 2-3   Import Summary - Multi-Layer Switch

When you want to view the source files for the device, the menu choices include 
both files. You can view source files for both the Layer-2 portion of the device 
and the Layer-3 portion. Similarly, you can view the import log generated by the 
import of each configuration file, as shown in Figure 2-4, yet the two files make 
one node in the model:

Figure 2-4   Source Files and Import Log - Multi-Layer Switch

Two files imported; one 
device created.
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If a multi-layer switch configuration file is examined during import and found to 
have an active (not shutdown) VLAN interface for which no corresponding 
switch configuration file is located, however, DCI will skip the import of the entire 
device with an error message: “File name: my-file-name.txt File skipped 
because Layer 2 configuration file is not available for the multi-layer switch 
‘my-host-name’.”

Note—Device import preferences are not visible until you have performed at 
least one device configuration import. If you have not done an import, you can 
begin an import and cancel out. The preferences then become available.

If you want to change the default behavior, so no devices will be skipped during 
import, you need to change an import preference, as described in Setting Import 
Preference to Allow Partial Import on page MVI-A-6.

Importing Cisco 6500 Multi-Layer Switches with Dual MSFCs

IT Guru supports Cisco 6500 series multi-layer switches with dual Multilayer 
Switch Feature Cards (MSFC). These switch types are imported into the 
network model as multi-module switches, as shown in Figure 2-5.

Figure 2-5   Multi-Module Switch in Network Model
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The MSFC adds routing functionality to the switch. With dual MSFCs, the 
multi-layer switch has redundancy capabilities that can be configured in different 
ways, depending upon the OS type: Native IOS or Hybrid OS. Table 2-3 
describes the various configurations and the files required during import:

Note—Cisco Catalyst 5500 multi-layer switches with dual route switch modules 
(RSM) are imported as multi-module switches with only one RSM configuration 
file. 

Note—For hybrid dual router mode (config sync disabled), only the 
configuration for the designated MSFC is imported. 

Table 2-3 Required Files per Configuration Type in Cisco Catalyst 6000 Switches

OS Type Router Mode Redundancy Mode
# of Active 
Routing MSFCs Config Files Required

Hybrid OS Dual Config Sync Enabled 2 • One IOS Config File

• One CatOS Config File

Config Sync Disabled 2 • Two IOS Config Files

• One CatOS Config File

Single Not Configured 1 • One IOS Config File

• One CatOS Config File

Native IOS Single SSO—Stateful 
Switchover

1 • One IOS Config File

RPR—Route 
Processor 
Redundancy

1 • One IOS Config File

RPR+—Route 
Processor 
Redundancy Plus

1 • One IOS Config File

End of Table 2-3
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Once the dual-MSFC devices are imported, the network model reflects the 
configurations in the following way.

After import, you can see the type of redundancy that is configured by examining 
the MSFC Mode attribute, shown in Figure 2-6. 

Figure 2-6   MSFC Mode Attribute

Table 2-4 Model Attributes for Device Configurations

OS Type MSFC Parameters.MSFC Mode Non-Designated Router Compound Attribute

Native IOS (Single Router) • Native-SSO

• Native-RPR

• Native-RPR+

Not applicable.

Hybrid OS, Single Router 
Mode

Hybrid-SRM Not applicable.

Hybrid OS, Dual Router 
Mode (Config Sync Enabled)

Hybrid-DRM
Configuration Synchronization: 
Enabled

Contains the configuration for the non-designated 
MSFC.

Hybrid OS, Dual Router 
Mode (Config Sync 
Disabled)

Hybrid-DRM
Configuration Synchronization: 
Disabled

Not configured. Only the configuration for the 
designated MSFC is imported.

Hybrid OS, Independent 
MSFC Devices (No 
redundancy)

Hybrid-Independent Not configured. Only the configuration for the 
designated MSFC is imported.

End of Table 2-4

This switch is running 
Native IOS and is 
using RPR for 
redundancy.
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Hybrid OS As you can see from Table 2-3, in a multi-layer switch using Hybrid 
OS, you can configure redundancy on a switch that is in dual router mode 
(DRM) by enabling or disabling config sync. When config sync is enabled, one 
configuration file serves both MSFCs, with the “alt” keyword separating one 
MSFC configuration from the other. A sample configuration is shown in 
Figure 2-7. In this case, both the designated and non-designated router 
configurations are imported and available.

Figure 2-7   Sample Configuration—Dual MSFC/Config Sync Enabled

When config sync is disabled, each MSFC has its own configuration file, 
although both files must share some attributes in common, per Cisco 
requirements. In this case, only the designated MSFC configuration is imported 
and available.

Import considers dual MSFCs in terms of designated and non-designated 
status. The designated MSFC is the one that came up first or has been up the 
longest. The non-designated MSFC is actively building routing tables but does 
not control the forwarding table. 

When a switch is in single router mode, only one MSFC is active and visible to 
the network. The other MSFC provides hardware redundancy only.

Native IOS A multi-layer switch using Native IOS is always in SRM and has 
redundancy configured in one of three ways:

• Stateful switchover (SSO)

• Route processor redundancy (RPR)

• Route processor redundancy plus (RPR+)

Note—Figure 2-6 shows the supported redundancy modes.

ip subnet-zero
!
ip default-gateway 9.9.9.9 alt ip default-gateway 10.10.10.10
!
no ip domain-lookup
!
ip ssh time-out 120
ip ssh authentication-retries 3
redundancy
high-availability
config-sync
!
!
!
!
!
interface Vlan1
ip address 10.0.3.18 255.255.255.0 alt ip address 10.0.3.19 255.255.255.0

i i
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Figure 2-8 shows that a multi-layer switch with dual MSFCs contains two 
compound attributes: MSFC Parameters and Non-Designated MSFC 
Configuration. 

Figure 2-8   MSFC Configuration

The exact attribute mapping and supported commands are described on the 
OPNET Support website, located here: 
http://www.opnet.com/support/home1.html. Click on Supported Vendor 
Protocols and Commands.

For information on the “show” commands required to properly import devices 
with dual MSFCs, refer to Table 2-2.

Restricting Import to Layer-3 Devices

You can set a preference to import Layer-3 devices only. When this preference 
is enabled, DCI will include these devices types in the imported topology:

• Routers/Layer-3 modules (IOS/JUNOS)

• Router-Switches (Hybrid OS/Native IOS)

• PIX Firewalls

It will not include

• Catalyst Switches (CatOS)

• IOS Switches
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To enable this preference, follow the steps in Setting Import Preference for 
Layer-3 Devices Only on page MVI-A-5, selecting the preference: 
device_import.layer3_only_import. 

Note—Router-Switches will only have the Layer-3 components imported when 
this preference is enabled.

Inferring Layer-3 IP Clouds

Tunnel interfaces in your network can have physical connectivity through 
Layer-2 devices where you do not have network access. During a DCI import, 
Layer-3 IP clouds are inferred for these tunnel interfaces when there is sufficient 
IP tunnel information in your available configuration files. This is often true when 
Frame Relay or ATM is configured in a network and the physical path of the link 
goes through a leased ISP network. By default, DCI will include these inferred 
Layer-3 IP clouds in the imported topology.

Note—During import, if you choose “Reimport configuration for selected 
devices” or “Reimport configuration for modified devices” in the Import Device 
Configuration dialog box, the Layer-3 IP clouds will not be inferred.

To change this preference, follow the steps in Procedure A-6 Disable Import 
Preference to Infer Layer-3 IP Tunnel Cloud on page MVI-A-6, selecting the 
preference: device_import.tunnel_cloud_import.

Importing VoIP Devices

You can control how your Voice over IP (VoIP) devices are imported by setting 
the device_import.import_voip_configuration preference.

• ENABLED—(default) When the preference is set to ENABLED, the VoIP 
device is imported as a multi-service switch. All attributes are mapped as 
expected. 

• DISABLED—When the preference is set to DISABLED, the VoIP device is 
imported as a router. All VoIP configurations are ignored, and a message is 
written to the import log.
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Troubleshooting the Import

The initial network model is built from the imported device files. If adequate 
planning is not done before the import, the network model might not appear as 
expected. It is important to understand these issues prior to performing an 
import, so you may avoid surprises in the resulting topology. After the import, 
you may notice some of the following issues:

• Missing Devices—Expected devices not showing up in model

• Phantom Devices—Unexpected devices appear in model

• Inferred Layer-3 IP Clouds—Unexpected Layer-3 IP Clouds in model

• Differences in Connectivity—Physical connectivity is not as expected

• Network Clouds—Multiple subnets represented as one or more clouds

• Differences in Devices—Devices are not as expected

• Post-Import Caveats

Missing Devices You may notice that some expected devices are missing from the network 
model after an import. Missing devices can be caused by the following expected 
behavior:

• If a configuration file is not provided for a device, the device is not imported 
into the network model. Be sure to include all device configurations in the 
appropriate directory.

• If the show version command is not executed for a device, it may not 
appear in the network model.

• If a VLAN interface is encountered during import, DCI will expect to have a 
corresponding switch configuration file. If none is found, DCI will skip the 
device with that interface with an error message. For more information on 
changing this behavior, see Importing Multi-Layer Switch Configurations on 
page MVI-2-7.

• If you have a multi-layer switch with dual Multi-Service Feature Cards and did 
not include the output of show module, show version, and show 
redundancy, depending on your OS version, import may skip the device. 
See Table 2-2 on page MVI-2-4 for more information on required commands.

• If you have a multi-layer switch but did not include the output of show cdp 
neighbors detail, you may have two separate devices appearing in the 
network model (or neither, as mentioned in the previous bullet). If you choose 
not to re-import with the cdp information appended, you can create a model 
assistant file to couple the two devices, using Procedure 2-1. When you 
perform your next import, be sure to specify the model assistant file you 
created. The multi-layer switch will appear as one device.
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Procedure 2-1   Create a Model Assistant File to Join Multi-Layer Switch

1 Select Topology > Model Assistant > Edit File...

➥ The Edit Model Assistant dialog box opens.

2 Click on the Router/Switch Coupling tab.

Note—You may need to scroll to the right to see this tab. Use the directional arrow 
in the upper right corner.

3 Click in the Rows box, in the lower left corner, and increment the number by one to 
add a row.

4 Click on Specify... under Router Name, and enter the name of the Layer-3 device.

Note—This is the name of the RSM/MSFC/RSFC.

5 Click on Specify... under Switch Name, and enter the name of the Layer-2 device.

6 Save the Model Assistant file for use with future imports.

End of Procedure 2-1

Phantom Devices After an import, the network model may contain devices that you did not include 
in the configuration data. These inferred devices are created when two or more 
routers have interfaces to the same IP subnet. In this case, DCI uses a generic 
cloud model to connect the interfaces. The cloud model used to represent the 
IP subnet corresponds to the type of interfaces being connected and each cloud 
node is given the name of the IP subnet it represents.

In the following example network, DCI inferred and created an Ethernet switch 
between three router interfaces. This occurred because three configuration files 
specified interfaces that connect to the same IP subnet. All other interface data 
specified one-to-one connections, so DCI did not create additional switching 
devices.

Figure 2-9   IP Interface Connections in a Generated Topology

192.62.50.112/29

192.62.50.114

192.62.50.113

192.68.50.113
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Inferred Layer-3 IP
Clouds

After an import, the network model may contain Layer-3 IP clouds that were not 
in your configuration. These inferred IP clouds are created when there is no 
information about Layer-2 connectivity, but there is sufficient IP tunnel 
information to infer an IP connection between two interfaces. DCI uses an IP 
cloud model to connect the interfaces.

The IP clouds that appear in your network model after an import are created 
based on imported configuration files and the setting for the environment 
preference device_import.tunnel_cloud_import. There are two 
possible settings for this preference:

• TRUE—This is the default value, which will infer Layer-3 IP clouds based on 
the tunnel interface information in the import file.

• FALSE—This option will not infer Layer-3 IP Clouds. Tunnel interfaces will 
not be connected in the network model when there is no information about 
Layer-2 connectivity between the interfaces.

Differences in
Connectivity

DCI depends on certain information in the configuration files to make decisions 
about link names, connections, link types, and link speeds between end-points. 
The information in this section describes how the connectivity decisions are 
made.

• When importing router configuration data, DCI relies on the IP, Frame Relay 
or ATM information in your configuration files to configure router 
connections.

• By default, DCI names all interfaces based on the names found in the 
configuration files. If an inferred router model is used to represent the 
imported device and has extra interfaces, the interfaces are shutdown by 
default and have generic names in the format “IFn” (IF0, IF1, and so on).

• Interfaces that are part of an aggregate interface, such as EtherChannel, are 
connected based on the configuration of the aggregate interface.

• DCI colors each link according to its underlying technology (Ethernet, Frame 
Relay, ATM, etc.) and auto-assigns a name that indicates both interfaces to 
which it is connected.

• DCI treats all DPT/SRP interfaces as serial (PPP) interfaces.

• If the import process cannot determine an interface data rate from a 
configuration file, and you do not specify a data rate in the Import Assistant, 
DCI assigns default rates of T1 for serial interfaces and OC3 for ATM 
interfaces.

• Frame Relay and ATM interfaces that are connected through a 
homogeneous Layer-2 network are imported as Frame Relay and ATM 
interfaces. If these interfaces are connected through a Frame Relay-ATM 
Service Interworking (FRASI) switch, using a mixture of Frame Relay and 
ATM, the switch is modeled as an FRF.8 FRASI switch in the network. 
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However, if these interfaces are connected through a heterogeneous 
Layer-2 network (containing Ethernet, as well as Frame Relay and ATM, 
within the same IP subnetwork), the interfaces are imported as serial 
interfaces to allow for connectivity.

• You can control whether or not DCI creates a serial cloud for mixed 
technologies by setting the preference 
device_import.create_serial_cloud. Possible selections are 

— TRUE: The following mix of interfaces is converted to a serial 
cloud—ATM + Frame Relay, ATM + Frame Relay + Serial, ATM + Serial, 
or Frame Relay + Serial. 

— FALSE: ATM + Frame Relay is imported as a combined FR/ATM switch. 
Other connectivity is not inferred.

— PARTIAL (default): ATM + Frame Relay + Serial, ATM + Serial, or Frame 
Relay + Serial are converted to a serial cloud. ATM + Frame Relay is 
imported as a FR/ATM switch with no conversion necessary.

• For Frame Relay PVCs, the output from the show frame-relay map 
command will override PVCs configured in interface mode using the 
command frame-relay map ip.

• For ATM PVCs, the output from the show atm map command will override 
PVCs configured in interface mode using the command pvc along with the 
protocol command.

Network Clouds The clouds that appear in your network model after an import are created based 
on imported configuration files and the setting for the environment preference 
device_import.collapse_clouds. There are three possible settings for 
this preference:

• Don’t Collapse—This is the default value, which specifies that no clouds are 
collapsed during import. The result is that devices belonging to different 
subnets are imported as separate clouds. This may not be an accurate view 
of your network.

• Collapse All—This option causes all imported clouds to be collapsed into a 
single cloud called “Network Cloud”.

• Collapse per Protocol—This option causes clouds to be collapsed per 
protocol—ATM, Frame Relay, and serial—into either a cloud called “ATM 
Cloud” or a cloud called “Serial Cloud”, which comprises both Frame Relay 
and serial links.

Changing this preference changes the appearance of your network model after 
import.

Differences in
Devices

DCI searches the model directories during the import for the device model that 
best matches each configuration file. If a matching device is not found, you may 
discover that the representative device does not suit your needs.
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For example, the default device for a Cisco 12012 has 10 ATM ports, 8 Fast 
Ethernet ports, and so on. Suppose your specific router has no ATM ports but 
is loaded with Gigabit Ethernet and Fast Ethernet ports. Rather than showing 
too many ATM ports (in a shutdown status), it is better to define your unique 
devices in advance of the import.

Adding devices is described in Creating Device Models (Optional) on 
page MVI-2-7.

Missing VLANs If a Cisco switch is configured as a VTP client, the configuration file may not 
contain all of the VLANs supported on the device. This results in an incomplete 
network model upon import. To avoid this problem, include the output of the 
“show vlan” command in the device configuration files, as described in 
Table 2-2. The concise import summary report, shown in Figure 2-15, reports 
devices for which the “show vlan” output is missing. 

Post-Import Caveats If you plan to import traffic into the network model, there are some things to bear 
in mind with regard to expected DCI behaviors:

• DCI creates a list of aliases for each router that includes all IP addresses for 
which that router is responsible. With the exception of switches that have a 
Layer-3 card, no aliases are created for Layer-2 objects such as switches 
and clouds.

• By default, the import process does not create any traffic source or 
destination nodes (such as workstations or LANs). You can create LAN 
nodes at the edge of the network model by enabling the Create Edge LANs 
option in the Import Device Configurations dialog box. See Performing an 
Import with DCI on page MVI-2-19 for details. This option automatically 
creates Ethernet, Frame Relay, serial, ATM LANs, FDDI, or Token Ring.

Performing an Import with DCI

When you have completed your preparations for an import, you can continue 
with an import, as described in Procedure 2-2. 

Note—Be sure to check the box to “Use Startup Wizard when creating new 
scenarios” when you create a new project or scenario, as shown in Figure 2-10.
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Figure 2-10   Enable Startup Wizard

Procedure 2-2   Importing a Topology from Device Configuration Files

1 Open the Import Device Configurations dialog box. You can open this dialog box 
in one of two ways:

• To import into a new scenario, choose Import From Device Configurations in the 
Initial Topology window of the Startup Wizard.

Note—Be sure to check Use Startup Wizard when creating new scenarios, or 
the Startup Wizard will not appear.

Figure 2-11   Enable Startup Wizard

• To import into an existing scenario, choose Topology > Import Topology > 
From Device Configurations...

Either action opens the Import Device Configurations dialog box, shown in 
Figure 2-12.
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Figure 2-12   Import Device Configurations Dialog Box

2 Select one of the following import modes.

• Replace Entire Model—Use this option when creating a new project or scenario, 
or when you want to overwrite the existing topology.

• Merge with Existing Model—Use this option to add devices to the existing 
topology. If some of the devices are already in the topology, these devices are 
replaced (that is, reimported) using the configuration files of this import. DCI 
matches the devices based on the hostname of the node.

• Reimport Configurations for Selected Devices—Use this option to update the 
configuration files of a few devices in the existing topology. The devices must 
already be selected in the workspace. If the devices you want to update are not 
currently selected, cancel this operation, select the devices, and start over.

In this mode, you do not need to specify the location of the configuration files in 
step 3, DCI uses the file specified in the Import Information attribute on the 
device. During the first import, DCI creates a new directory and copies the config 
files into that directory. Upon subsequent imports, the new directory is 
referenced.

• Reimport Configuration for Modified Devices—When you select this option, DCI 
will reimport configuration files for any devices that have been modified since the 
last import, based on comparison of the timestamp of the last import and the 
current time.

3 For each directory from which you want to import, use the following steps to specify 
where the configuration files are located.

3.1 Click the Add Row button.

3.2 Select the appropriate vendor(s) in the new row, using the drop-down menu. 
Choices include Cisco, Juniper, or Cisco and Juniper.
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3.3 Enter the directory path in which the files are located.

Note—Alternately, you can browse and select in a directory chooser using the 
Browse button.

3.4 Select Yes or No in the Include Subfolders column.

3.5 To specify additional directories or to remove information

• To add more directories, select Duplicate Row or Add Row. 

• To remove a row, select Delete Row.

• To remove all directory information, select Clear All.

4 Select import options. The options are described in Table 2-5:

5 Select or deselect the “Use the following model assistant files” checkbox. If this box 
is deselected, DCI will not consider any model assistant files specified in step 6. 
DCI will still use CDP information, however, to infer Layer-2 connectivity and 
router-switch coupling. If this box is selected (default), DCI will consider the model 
assistant files specified by the user in step 6.

Table 2-5   Device Configuration Import Options

Import Option Description

Create nodes to represent 
external ASes.

Reads external BGP peering, and if there is no external 
partner, IT Guru creates another AS to connect to.

When this option is checked, DCI imports the BGP-RIB 
information for EBGP connections. The RIB-in data of the 
border router of the local AS is used as the RIB-out on the 
external AS node. The RIB-out files are automatically 
generated and specified on the AS nodes.

Create nodes to represent 
edge LANs.

Creates LAN nodes at the edge of the network topology. LANs 
are created on device edges if an IP interface is active but not 
connected to another device in the import.

Create PVCs Reads static PVC mapping from configuration and builds the 
mesh accordingly. If there are no static maps, DCI will create 
a full mesh of PVCs across all interfaces in the same IP 
subnet. When this option is not selected, DCI does not create 
PVCs during the import—even when static mapping is in the 
imported device configuration.

NOTE: This option is new for release 11.0. Previous releases 
had option “Create Full Mesh PVCs,” which did not read static 
mapping for PVCs.

Generate Import Log Creates a log that lists the commands that were skipped (not 
considered) during the import. The log also contains 
diagnostic messages generated by the import.

End of Table 2-5
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6 Specify one or more model assistant files. These files can be model assistant files, 
which have a .ma extension, or import assistance files from releases prior to 10.0, 
which have a .ia extension. See Model Assistant on page ITU-6-50 for more 
information about model assistant files.

Note—As of release 11.0, you may select or deselect a checkbox that tells DCI 
whether or not to consider model assistant files when performing an import. By 
default the box is selected.

7 If you have a Sentinel or Automation license, and want to save your import settings 
to an automation file, click the Save Settings for Automation button and specify a 
name for the automation file.

8 Click Import.

➥ IT Guru generates a network topology and configures routing and switching 
attributes on the nodes according to the information in the configuration files. If 
additional information is needed to complete the import, a dialog box appears 
prompting you to open the Import Assistant. See Using the Import Assistant, for 
more information.

End of Procedure 2-2

The configuration files do not always contain all of the information that can be 
included in a network model. Although you can manually specify additional 
information after the import, IT Guru has two assistants that can automate the 
process.

• Import Assistant—When the configuration files do not have some of the 
information that DCI needs to complete the topology, the Import Assistant 
appears after the import. See Using the Import Assistant.

• Model Assistant—Unlike the Import Assistant, which prompts you for 
required information, Model Assistant files let you specify additional 
information about one, several, or all of the objects in a network. See Using 
Model Assistant Files with Imported Topologies on page MVI-2-29.

Using the Import Assistant

Sometimes the configuration files do not have all the information that DCI needs 
to fully configure the device models. When this happens, you need to supply the 
missing information after the import. The missing information that can be 
specified in the Import Assistant falls into the following categories:

• IP-unnumbered interfaces—DCI knows that the interface or port is 
connected to another but is unable to determine the identity of the other 
interface or port. 

• Unspecified data rates—DCI connects two interfaces or ports but cannot 
determine the data rate of the connection.
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When additional import information is needed, the following dialog box appears:

Figure 2-13   Device Configuration Import: Further Information Required

At this point, you can specify information for IP unnumbered interfaces and 
interfaces with unspecified data rates. Using the Show pull-down menu (top 
left), you can display either category of interfaces with missing information or all.

Figure 2-14   The Import Assistant

Show routers with unnumbered interfaces

Show routers with unspecified interface data rates
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Connecting Unnumbered Interfaces If there are any IP-unnumbered interfaces 
in the network model, the Import Assistant opens with the Show menu set to 
Routers with unnumbered interfaces. All such routers (and their unnumbered 
interfaces) appear with red icons in the treeview. Follow Procedure 2-3 to 
connect the unnumbered interfaces. 

WARNING—This procedure applies only to interface connections that were 
missing in the configuration data; you cannot use this method to change 
connections that were set during the import (which appear with dark green icons 
in the Import Assistant). 

When you have connected all unnumbered interfaces, all of the formerly red 
icons will be light green, indicating that the interface has been modified and is 
now properly connected.

Note—You can avoid the occurrence of IP-unnumbered interfaces by ensuring 
that you have the output of show cdp neighbors detail command in your 
configuration files.

Procedure 2-3   Connecting Unnumbered Interfaces

1 Make sure that the Show pull-down menu is set to “Routers with unnumbered 
interfaces”.

➥ All routers with IP-unnumbered and disconnected interfaces appear in the 
Interface A pane.

2 In the Interface A pane, select an unnumbered interface. Note that clicking on the 
plus sign (Windows) or arrow (Solaris) next to the router icon will expand the view 
of the router to include its name and interfaces.

➥ A list of routers with eligible interfaces appears in the Interface B pane.

Interface A pane Interface B pane
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3 In the Interface B pane, select the interface you want to connect to the interface 
selected in the Interface A pane.

4 Click Connect.

➥ The two interfaces are connected. Interface B disappears from the right pane; 
the icons for interface A change from red (Needs data) to light green (OK, 
modified).

End of Procedure 2-3

Specifying Data Rates You can set or change the data rate for any connected 
router interface in your network. When you set a data rate, the change affects 
both connected interfaces.

Procedure 2-4   Specifying the Data Rate of an Interface

1 Set the Show pull-down menu to “Routers with Unspecified Data Rates” or “All 
routers”.

➥ A list of all routers in the network appears. The routers that have interfaces with 
unspecified data rates appear with red icons.

2 Select the interface whose data rate you want to change. You can select multiple 
interfaces by holding down the Control key and clicking on multiple interfaces. The 
data rate indicated for an interface is the default data rate that will be assigned if 
you do not specify the actual data rate.

If you do not specify a data 
rate, the default rate is 
assigned. The default rate 
for this ATM interface is 
SONET/OC3. 
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3 Choose a data rate from the Data Rate pull-down menu. If the rate you want does 
not appear on this menu, choose Edit and specify the data rate (in bps). Then click 
Apply.

➥ The Data Rate fields for both interfaces are updated to reflect the change, and 
the interfaces now have light green (OK, modified by user) icons.

Note—If the icon for an interface is still red after you have specified a data rate, the 
interface is not connected. Connect the interface as described in Connecting 
Unnumbered Interfaces on page MVI-2-25, then set the data rate.

End of Procedure 2-4

You can save the changes you made to a model assistant file, which you can 
then use during another import. To create a model assistant file from the 
changes made in the Import Assistant, click Save changes after you have 
specified all of the missing information. The model assistant file is created in the 
primary models directory with the name you specify. For information about 
editing model assistant files, see Model Assistant on page ITU-6-50 of the Guru 
User Guide. 

Viewing the Import Summary Report

When the import is complete, a concise import summary opens. The report 
contains single-line descriptions and counts of significant events that occurred 
during the import.

Figure 2-15   Concise Import Summary Report

By resting the cursor over each item, you can see expanded information about 
the event(s) in the form of a tooltip.
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The View Details button, when clicked, opens a full import summary report.This 
report contains more information about the import including the timestamp, 
duration of process, specified import mode and options selected. It also shows 
the directory from which the device configuration files were imported and issues 
that were identified by the Import Assistant during the process.

Figure 2-16   Import Summary Report
MVI-2-28 IT Guru/Release 11.5



MVI User Guide for IT Guru 2—Importing Topologies
If you wish to review this import summary or other import summaries for 
previous imports, right-click in the workspace and choose View Import 
Summary. A dialog box opens that contains a list of import summary reports 
from previous device configuration imports. You can select any of the available 
reports for viewing.

Figure 2-17   View Import Summary

Using Model Assistant Files with Imported Topologies

Model assistant files let you specify information about the network topology that 
is not included in the configuration files.

WARNING—If you do not convert your pre-11.5 model assistant files containing 
networks imported through DCI, they will not work in 11.5.

To apply model assistant files after importing a network, use the procedure 
described in Model Assistant on page ITU-6-50 of the Guru User Guide. You 
can also apply model assistant files during the import, by specifying the files in 
the Import Device Configurations dialog box. If you specify information about 
unnumbered interfaces and unspecified data rates in model assistant files, 
applying the files during the import lets you bypass the Import Assistant.

For general information about how to create, edit, and apply model assistant 
files, see Model Assistant on page ITU-6-50 of the Guru User Guide.
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After the Import

Although you have imported a virtual model of your network, the live network 
continues to evolve. OPNET allows you to manage the network model along 
with the changes to your “real” network.

• Incremental Imports and Updates to Network Model

• Viewing the Import Log

• Viewing and Editing Configuration Files After an Import

• Using the Virtual Command Line Interface

• Network Inventory Summary Report

Incremental Imports and Updates to Network Model

You can use DCI to update an existing network topology, whether or not that 
topology was created with DCI. You can:

• add new devices to the network

• update the configuration files of some devices

• do a new import for the entire network

An import of a network model subsequent to an initial import is also called an 
incremental import. There are several ways to perform an incremental import. 
Refer to Procedure 2-2 and note the following import modes related to 
incremental imports:

• Merge with Existing Model—Use this option to add devices to the existing 
topology. If some of the devices are already in the topology, these devices 
are replaced (that is, reimported) using the configuration files of this import. 
DCI matches the devices based on the hostname of the node.

• Reimport Configurations for Selected Devices—Use this option to update the 
configuration files of a few devices in the existing topology. The devices must 
already be selected in the workspace. If the devices you want to update are 
not currently selected, cancel this operation, select the devices, and start 
over.
MVI-2-30 IT Guru/Release 11.5



MVI User Guide for IT Guru 2—Importing Topologies
You do not need to specify the location of the configuration files; DCI uses 
the file specified in the Import Information attribute on the device. By default, 
this is the location specified in the original import.

• Reimport Configuration for Modified Devices—When you select this option, 
DCI will reimport configuration files for any devices that have been modified 
since the last import, based on comparison of the timestamp of the last 
import and the current time.

Note—No changes affecting network topology (i.e., addition/deletion of 
interfaces, IP address change, or change in interface status) as created during 
import from VNE Server are applied during increment DCI.

The import mode, Reimport Configuration for Modified Devices, is the fastest 
method, especially for large networks. If the network is relatively small, or if you 
have many changes, consider replacing the entire model. All options use the 
basic import procedure described in Procedure 2-2. They differ only in the 
import mode used in the Import Device Configurations dialog box.

When adding new devices to an existing network or updating the configuration 
files for a few devices in the network, create a directory that contains only the 
configuration files of the new devices you want to import. Specify this directory 
in the Import Device Configurations dialog box and make sure that you are using 
the import mode specified in Table 2-6.

Table 2-6   Import Mode Usage for Updating Imported Topologies

To... Use This Import Mode...

Add new devices to an existing network Merge with Existing Model

Update the configuration files of some nodes Reimport Configurations for Selected 
Devices

Perform incremental import of changes in the 
network model

Reimport Configuration for Modified 
Devices

Reimport the files of all devices in the network Replace Entire Model

End of Table 2-6
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Viewing the Import Log

During the import, some commands in the device configuration files may have 
been skipped or ignored. You can see which commands were skipped during 
the import by selecting View Device Configuration Import Log from the 
Workspace pop-up menu. You can view the import log for an individual node by 
selecting View Device Configuration Import Log from the node’s Object pop-up 
menu.

Figure 2-18   DCI Import Log
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Viewing and Editing Configuration Files After an Import

After an import, you can view the configuration file that DCI used to create a 
node in the Project Editor. To do this, select View Device Configuration Source 
Data from the node’s object pop-up menu.

Procedure 2-5   Editing a Configuration File of a Device

1 Right-click on the device in the Project Editor workspace and select View Device 
Configuration Source Data from the pop-up menu.

➥ The configuration file appears in a text edit pad (see Figure 2-19 on 
page MVI-2-33).

2 Edit the configuration file.

3 Choose File > Save to save your changes.

4 Close the text edit pad.

End of Procedure 2-5

After editing a configuration file in IT Guru, you need to import the updated 
configuration file so that the changes you made are included in the topology. 
See Incremental Imports and Updates to Network Model on page MVI-2-30 for 
more information.

Figure 2-19   Viewing the Device Configuration File After Import
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Using the Virtual Command Line Interface

The last section described how to permanently edit your configuration files 
through a text editor. If you want to edit the devices only for a particular project, 
you can use Virtual Command Line Interface (Virtual CLI), which allows you to 
edit Cisco routers and switches within the network model. The changes made 
with Virtual CLI are specific to the project within which you are working and do 
not affect the underlying source files. 

The Virtual CLI has the same look and feel as the Cisco CLI, although it 
supports a sub-set of Cisco commands. Virtual CLI supports familiar Cisco CLI 
usage including shortcuts (such as typing ena instead of enable), command 
help access via “?”, and tab completion of a command.

To access the Virtual CLI, right-click on a Cisco router or switch and select Open 
Virtual CLI... Figure 2-20 shows an example of a Virtual CLI session.

Figure 2-20   Virtual Command Line Interface
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Network Inventory Summary Report

After an import, and on a periodic basis, you may want to see how many devices 
are in your network and of what type. If you have a rather small imported 
network model, it is a simple task to visually gather this information. For larger 
networks, however, it is a time-consuming, error-prone task to take inventory. 
The Network Inventory Summary report is available at any time after an import. 
Running a Network Inventory Summary report after an incremental import 
allows you to keep your inventory files up-to-date. In Figure 2-21 you can see 
that there are two ways to generate the report: through the drop-down menus or 
through the toolbar.

Figure 2-21   Generating a Network Inventory Summary

An example of a Network Inventory Summary report is shown in Figure 2-22. 
The summary includes 

• Devices—A total count of devices, and a breakdown by device type

• Vendors—A count by vendor

• Physical Links—A total count of physical links, and a breakdown by type

• Virtual Links—A total count of virtual links, and a breakdown by type

• Other—A total count of other types of devices in the model, including network 
clouds, application models, configuration utilities, etc.

Generate a Network 
Inventory Summary
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Figure 2-22   Network Inventory Summary

If a count listing is in blue text, there are further actions you can take. In the 
example shown here, you can also drill down into the Cisco listing for specifics 
about the devices found. Notice in the Device Details dialog box, shown in 
Figure 2-23, more counts are in blue text.

Figure 2-23   Vendor Detail
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To drill down even further, you can click on any number in blue. In the example 
shown in Figure 2-24, the four Cisco WS-C2924M-XL switches are listed.

Figure 2-24   Detail of Cisco Model WS-C2924M-XL

At any point in the summary, you can also export the report to any of the 
following file types:

• Spreadsheet (for example, MS-Excel)

• Comma-Separated ASCII 

• Web Report

• XML

Figure 2-25   Export Network Inventory Summary
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Exporting the report makes it easier to use the information for analysis, 
management reporting, and other requirements. Figure 2-26 shows an example 
of this Network Inventory Summary report exported to a web report format.

Figure 2-26   Export to a Web Report
MVI-2-38 IT Guru/Release 11.5



MVI User Guide for IT Guru 3—Importing Traffic Flows
3 Importing Traffic Flows

This chapter describes the traffic-flow data formats you can import with the MVI 
module, and includes information specific to each format. For general 
information about importing traffic flows, see Chapter 11 Importing Traffic Flows 
on page ITU-11-1 of the Guru User Guide.

Table 3-1   MVI Module: Supported Traffic-Flow Imports

File Format / Program Reference

cflowd Creating cflowd Data on page MVI-3-8

NAI Distributed Sniffer

NAI Sniffer Prof

Creating Distributed Sniffer/Sniffer Pro Data on page MVI-3-2

Fluke OptiView Creating OptiView Console Traffic Files on page MVI-3-5

Netflow Collector Creating NetFlow Collector Data on page MVI-3-3

End of Table 3-1
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Creating Distributed Sniffer/Sniffer Pro Data

This section describes the special requirements for creating traffic data files in 
Distributed Sniffer and Sniffer Pro. To see if your version of Sniffer is supported 
by IT Guru, go to http://www.opnet.com/support and follow the “System 
Requirements” link.

For information about importing traffic flows, see Chapter 11 Importing Traffic 
Flows on page ITU-11-1 of the Guru User Guide.

Procedure 3-1   Creating Sniffer Data Files

1 Open Sniffer Pro or Distributed Sniffer if it is not already open.

2 Create one or more Sniffer data files. Sniffer Pro and Distributed Sniffer capture 
traffic as a collection of connection objects (row type 0::400::3::XX in Sniffer traffic 
files). For more information, see the Sniffer documentation.

2.1 Click the Start button on the Sniffview toolbar.

2.2 Click the Stop and Display button on the Sniffview toolbar, when finished 
capturing.

3 Export the contents of each data file to a comma separated vector (.csv) file. Make 
sure you export the Overview, Title Heading and Object Summary fields in the 
Sniffer data; the .csv file must include these fields to be imported into IT Guru.

3.1 Click the Export CSV button in the dialog box, which says Ethernet Frames 
in the title.

3.2 In the Export Expert Objects into CSV dialog box, select as follows:

• Select a target directory where you wish to save the file.

• Specify a file name.

• Uncheck the following: Symptom Summary, Symptom Detail, Diagnosis 
Summary, Diagnosis Detail

• Click the Save button.

4 Prepare for the traffic import as described in Preparing for a Traffic or Link-Load 
Import on page ITU-11-9 of the Guru User Guide.

End of Procedure 3-1
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Creating NetFlow Collector Data

This section describes the special requirements for creating NetFlow Collector 
data files that you can import into IT Guru. To see if your version is supported 
by IT Guru, go to http://www.opnet.com/support and follow the “System 
Requirements” link.

For information about importing traffic flows, see Chapter 11 Importing Traffic 
Flows on page ITU-11-1 of the Guru User Guide.

Note—More information about configuring NetFlow export is available on the 
Cisco Systems web page at this location:
http://www.cisco.com/en/US/products/sw/iosswrel/ps1829/products_feature_g
uide09186a00800871a8.html#1015363

Procedure 3-2   Creating NetFlow Collector Data Files

1 In NetFlow Collector, you must create a data file that uses one of the following 
aggregation schemes:

• RouterAS or RouterPrefix

• CallRecord or DetailCallRecord

• AsHostMatrix or DetailHostMatrix 

The file must be in either Format A or Format 2.

For more information about NetFlow data file formats, see the Netflow 
documentation.

2 MVI can import uncompressed ASCII files only. You might need to manually 
uncompress a file and/or convert it from binary to ASCII before you can import it.

3 After you create your data files, prepare for the traffic import as described in 
Preparing for a Traffic or Link-Load Import on page ITU-11-9 of the Guru User 
Guide.

End of Procedure 3-2
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Importing Socket, Transport Protocol, and TOS Data

You can configure IT Guru to import socket, transport-protocol, or TOS 
information from NetFlow data files, and to create separate traffic flows for 
specific types of data. The type of data you can import depends on the type of 
aggregation used in the Netflow data file, as illustrated in Table 3-2. For more 
information, see Aggregating Traffic Flows on page ITU-11-19 of the Guru User 
Guide.

Table 3-2 Supported Aggregation Options for NetFlow Collector Imports

NetFlow Aggregation Transport Protocol Socket Type of Service

CallRecord X X X

DetailHostMatrix X X

AsHostMatrix

DetailCallRecord X X X

RouterAS

RouterPrefix

End of Table 3-2
MVI-3-4 IT Guru/Release 11.5



MVI User Guide for IT Guru 3—Importing Traffic Flows
Creating OptiView Console Traffic Files

This section describes the procedures for creating OptiView traffic data files that 
you can import into IT Guru. To see if your version of OptiView Console is 
supported by IT Guru, go to http://www.opnet.com/support and follow the 
“System Requirements” link.

For information about importing traffic flows, see Chapter 11 Importing Traffic 
Flows on page ITU-11-1 of the Guru User Guide.

OptiView Console can generate traffic data files subject to the following 
restrictions:

• OptiView Console can export IP-V4 traffic flows only.

• OptiView Console can export traffic from Fluke OC-3 WAN Analyzers only.

• OptiView Console can export a traffic flow only if it is among the 50 flows with 
the highest traffic levels (in packets/PDU and octets) visible to the WAN 
Analyzers.

• Traffic data is available for the previous seven days if imports have been 
enabled and the Import Service is running on OptiView Console. To import 
data for time windows earlier than the previous seven days, you must load 
archive data from the OptiView traffic agent. For more information, refer to 
the online documentation included with OptiView Console. 

There are two methods for generating OptiView traffic files:

• Manual generation, using the Optiview user interface—See Creating 
OptiView Traffic Files Manually (Graphical Interface) on page MVI-3-6)

• Automatic generation, using a command-line interface—See Creating 
OptiView Traffic Files Automatically (Command-Line Interface) on 
page MVI-3-7)
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Creating OptiView Traffic Files Manually (Graphical Interface)

To generate traffic files, open the OptiView Console Viewer and choose 
Tools > Export Flow Records to OPNET. This opens the Export Flow Data to 
OPNET dialog box, described in Table 3-3.

Figure 3-1   Export FLOW Data to OPNET Dialog Box

Table 3-3 Export FLOW Data to OPNET Dialog Box (OptiView Console)

Option Description

Select WAN Analyzers 
for Exporting FLOW Data

Select the WAN analyzers that you want to generate traffic data

Export Time Period Select the time window for the traffic you want to export.

Export Directory Destination directory for the OptiView data files. To automate the 
process of importing data into IT Guru, this directory should be 
listed in your traffic_archive_dir preference (to set this 
preference, open IT Guru and choose Edit > Preferences). 

End of Table 3-3
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Creating OptiView Traffic Files Automatically (Command-Line Interface)

You can generate OptiView data files using batch files or a command-line 
interface. This option is useful for generating data files automatically. You can 
create a batch file with one or more OptiView commands, then configure a 
scheduler to run the script at regular intervals (for example, once a night). 

The OpnetExporter command generates IT Guru-compatible OptiView data 
files. The format for this command is:

OpnetExporter -exportDir <directory> [-agents <agent_list>] [-<time_options>]

Table 3-4 OpnetExport Command-Line Arguments

Argument Description

-exportDir <directory> Destination directory for the OptiView data files. To automate the process of importing data 
into IT Guru, this directory should be listed in your traffic_archive_dir preference (to set this 
preference, open IT Guru and choose Edit > Preferences).

-agents <agent_list> A space-delimited list of WAN Analyzers. You can enter the Agent Name or Agent IP as it 
appears in the Export FLOW Data to OPNET Dialog Box (OptiView Console).

If this argument is not specified, OptiView generates data files from all listed agents. 

-<time_argument> The time window of the traffic data to export. You can specify one of the following 
arguments:

-allTime

-lastHour

-last2Hours

-last4Hours

-last8Hours

-last12Hours

-last24Hours

-customTime mm/dd/ccyy-hh:mm mm/dd/ccyy-hh:mm

If this argument is not specified, OptiView generates data for all available traffic. 

End of Table 3-4
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Creating cflowd Data

This section describes the special requirements for creating cflowd data files 
that you can import into IT Guru. To see if your version is supported by IT Guru, 
go to http://www.opnet.com/support and follow the “System Requirements” link.

For information about importing traffic flows, see Chapter 11 Importing Traffic 
Flows on page ITU-11-1 of the Guru User Guide.

Procedure 3-3   Creating cflowd Data Files

1 Create your cflowd data files using normal mode. IT Guru cannot import cflowd 
data that uses AS aggregation. For more information, see the cflowd 
documentation.

2 Run the flowdump utility on each cflowd traffic file. This utility is included with 
cflowd.

3 After you configure IT Guru, prepare for the traffic import as described in Preparing 
for a Traffic or Link-Load Import on page ITU-11-9 of the Guru User Guide.

End of Procedure 3-3
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Configuring NetScout nGenius and IT Guru

This section describes how to configure IT Guru and NetScout nGenius version 
1.3 so you can import traffic flows. Procedures might differ for other versions of 
nGenius. To see if your version is supported by IT Guru, go to 
http://www.opnet.com/support and follow the “System Requirements” link.

This section also includes troubleshooting information specific to nGenius; for 
more information, see Troubleshooting nGenius Imports on page MVI-3-13.

The workflow for nGenius imports is similar to most other types of traffic imports, 
with the following exceptions: 

• The nGenius import reads from a database, so you do not need to create 
individual files.

• You must do Procedure 3-4 to set up nGenius and IT Guru.

• When you import traffic, you must also log in to the nGenius database 
(Procedure 3-7 on page MVI-3-12)

For information about importing traffic flows, see Chapter 11 Importing Traffic 
Flows on page ITU-11-1 of the Guru User Guide.

Procedure 3-4   Configuring nGenius and IT Guru

1 Place the nGenius probe(s) on the network segment(s) to be monitored.

2 Configure the nGenius probe(s) to speak with NetScout. For more information 
about configuring NetScout nGenius, see the nGenius documentation .

3 Set nGenius preferences to specify the traffic you want to collect. For more 
information, see Setting nGenius Preferences on page MVI-3-10.

4 If you are using nGenius version 1.3 or 1.4, you must install special patch files to 
be able to import traffic data into IT Guru. These requirements are described in the 
following FAQs (Frequently Asked Questions):

• FAQ # 740 (nGenius version 1.3)

• FAQ # 908 (nGenius version 1.4)

These FAQs are available at the OPNET Support Center. Point your web browser 
to the OPNET Support Center (www.opnet.com/support) and follow the “FAQ” link. 
To access a specific FAQ, search for the FAQ number. To obtain a list of all 
relevant FAQs, search for the string "nGenius."

5 Set the preferences on your IT Guru computer, as described in Setting Preferences 
on Your IT Guru Computer on page MVI-3-11.

End of Procedure 3-4
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Setting nGenius Preferences This section describes several nGenius 
preferences that control the amount of data collected by Netscout probes and 
the amount of data stored in the nGenius database. To view and set these 
values:

1) Open the main nGenius Performance Manager window.

2) Go to the Administration page.

3) Choose Device > Global Settings.

Maximum Convs and Maximum Hosts This Maximum Convs [conversations] 
setting controls the maximum number of conversations (end-to-end traffic flows) 
that each probe interface logs to the database. The Maximum Hosts setting 
controls the maximum number of hosts logged by each probe interface. (These 
settings are located on the Logging Table Sizes tabbed page, under Maximum 
Number of Hosts and Conversations Logged.)

The Maximum Conversations limit is applied in conjunction with the Collection 
Threshold (%) setting. For example, assume a maximum of 50 conversations 
and a collection threshold of 80 percent. nGenius does the following:

1) Polls each probe interface for its conversations

2) Uses these metrics to determine what is logged

3) Sorts the conversations by utilization

4) Applies the following rule: Log 50 conversations, unless 80 percent of the 
visible traffic can be accounted for in fewer than 50 conversations

In a second example, assume a 100MB ethernet link with 10 percent average 
utilization for the polling interval. Assume this utilization is made up of eight 
conversations at 1 percent utilization each, and 200 smaller conversations that 
contribute the remaining 2 percent. If the collection threshold is 80 percent, 
nGenius logs only the eight conversations.

If the collection threshold is set to 100%, it has no effect on the Maximum 
Conversations setting.

Minimum Utilization The Minimum Utilization (%) setting specifies the minimum 
link utilization that must be consumed for a conversation to be logged. By 
default, it is set to 0.005%. Thus, any conversation that consumes less than this 
percentage of the link's total bandwidth is not logged. If you want nGenius to log 
all conversations, set the minimum utilization to 0. (This setting is located on the 
Logging Table Sizes tabbed page, under Minimum Utilization of Hosts and 
Conversations Logged.)
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Device Table Sizes The Device Table Sizes tabbed page contains settings that 
control the size of the tables used to store data. If the Maximum Convs setting 
for the Network Layer table size is set to 8000, nGenius will set the RMON2 
Network Layer Conv table size on your probes to 8000.

If the number of conversations in the Device Table Size for an interface is 
smaller than the Max. Convs setting, only the Device Table Size value will be 
stored.

Each device table can have a maximum size of up to 200,000. However, a probe 
might not have enough physical memory to allocate tables to their maximum 
sizes. You might see messages in the probe event log indicating that there was 
not enough memory to allocate tables of the requested sizes.

Setting Preferences on Your IT Guru Computer

The IT Guru system software installed on your hard drive or server includes an 
interfaces data file (interfaces in UNIX, sql.ini in Windows) with information that 
IT Guru uses during the nGenius import. You must set your preferences so that 
IT Guru can find the directory where this file is located.

Note—To import from nGenius, you must have read/write privileges for the 
interfaces file.

Procedure 3-5   Setting the SYBASE preference (UNIX)

1 Enter the following command from a UNIX command line:

cmd> setenv SYBASE <reldir>/sys/etc/sybase

<reldir> is the top-level directory where your IT Guru software resides on your 
hard drive or server; for example: /opt/OPNET/10.0.A.

End of Procedure 3-5

Procedure 3-6   Setting the SYBASE and SYBASE_OCS preferences (Windows 
NT/2000)

1 Right-click on My Computer and choose Properties. (The My Computer icon is 
usually located in the top-left corner of the Windows desktop.)

➥ The System Properties dialog box appears.

2 Click on the Environment tab to see your system and user variables.

3 Click in the System Variables field.

4 Enter “SYBASE” in the Variable field, and <reldir>\sys\etc\sybase in the 
Value field. 
IT Guru/Release 11.5 MVI-3-11



3—Importing Traffic Flows MVI User Guide for IT Guru
<reldir> is the top-level directory where your IT Guru software resides on your 
hard drive or server; for example: C:\Program Files\OPNET\10.0.A.

5 Click in the System Variables field again.

6 Enter “SYBASE_OCS” in the Variable field and \ in the Value field. 

7 Click the Set button, and then OK to close the System Properties dialog box.

End of Procedure 3-6

nGenius Import Procedure

The import procedure for nGenius differs slightly from other traffic-flow imports. 

Procedure 3-7   Importing Traffic Data from a NetScout nGenius Database

1 Add the nGenius databases’s host name or IP address to the ngenius_servers 
preference if this preference is not already set.

2 Open the IT Guru project and scenario into which you want to import traffic.

3 Choose Traffic > Import Traffic Flows > From NetScout nGenius.

➥ IT Guru prompts for the nGenius server name and your username/password.

The Database Host field specifies the logical nGenius database name specified in 
your interfaces file. The Username and Password fields specify the Sybase user 
name and password required for accessing the database.

4 Enter the user name and password for the nGenius database from which you want 
to import. Then click OK.

➥ The Traffic Import dialog box opens, showing all the traffic archives that can be 
imported. 

5 Click on the icon for the nGenius archive in the traffic-servers pane; this is grouped 
under the computer running nGenius. 

6 Enter the starting and ending times for the imported traffic in the Start and End 
fields, or leave the fields blank to import all traffic in the database. Then press 
Import.

Note—If you have an MVI license and this is your first time importing from an 
nGenius database, you may be notified that your license is not configured correctly. 
If this occurs, follow the steps presented in IT Guru and the license will configure 
itself. You must then restart IT Guru for the configuration changes to take effect.

7 When the Traffic Flows Import dialog box appears, proceed with the import starting 
with step 4 in Procedure 11-8 Importing Traffic Flows on page ITU-11-15 of the 
Guru User Guide.

End of Procedure 3-7
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Troubleshooting nGenius Imports

This section describes some potential problems you might encounter when you 
try to import traffic flows from nGenius. 

• Incorrect SYBASE preference—The SYBASE preference should point to the 
appropriate SYBASE client configuration directory. By default, this directory 
is located in

— <rel_dir>/sys/etc/sybase (Solaris)

— <rel_dir>\sys\etc\sybase (Windows)

Make sure that the directory set in the preference indeed exists and that the 
path does not include quotes.

• Incorrect file permissions—You must have the correct file permissions for the 
Sybase "interfaces" file. On Solaris, $SYBASE should be 
readable/executable, and $SYBASE/interfaces should be 
readable/writable. On Windows, %SYBASE% should be listable/readable, 
%SYBASE%/ini should be listable/readable/changeable, and 
%SYBASE%/ini/sql.ini should be readable/changeable.

• User authentication—Verify that you are entering the username/password 
that was created with the Sybase read-only user creation "patch" as 
described in FAQ 740 (for nGenius version 1.3) or FAQ 908 (for nGenius 
version 1.4 or higher). For information about these FAQs, see Procedure 3-4 
on page MVI-3-9.

• Network connectivity—Your IT Guru computer requires TCP/IP network 
connectivity to the nGenius database server. Use the “ping” command to see 
if your IT Guru computer can communicate with the nGenius server. 

• For information about other problems and potential solutions, see 
Troubleshooting Traffic-Flow Imports on page ITU-11-29 of the Guru User 
Guide.
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4 Importing Baseline Loads

This chapter describes the baseline load data formats you can import with the 
MVI module, and includes information specific to each format. For general 
information about importing baseline loads, see Chapter 12 Importing Baseline 
Loads on page ITU-12-1 of the Guru User Guide.

Table 4-1   MVI Module: Supported Baseline-Load Imports

File Format / Program Reference

MRTG (Multi-Router Traffic Grapher) configuration files MRTG Link Loads: Preparing for 
an Import on page MVI-4-2

InfoVista InfoVista Link Loads: Preparing 
for an Import on page MVI-4-4

HPOV Performance Insight Performance Insight Link Loads: 
Preparing for an Import on 
page MVI-4-8

Concord eHealth–Network Concord eHealth Baseline Loads: 
Preparing for an Import on 
page MVI-4-9

End of Table 4-1
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MRTG Link Loads: Preparing for an Import

IT Guru can import link loads from MRTG. Table 4-2 lists the steps to do before 
you import MRTG data. After you do these steps, proceed to Importing Baseline 
Load Data on page ITU-12-9 of the Guru User Guide.

Creating MRTG Link-Load Data

This section describes how to generate IT Guru-compatible data files in MRTG 
version 2.9. Procedures might differ for other versions of MRTG. To see if your 
version is supported by IT Guru, go to http://www.opnet.com/support and follow 
the “System Requirements” link.

To create log files that IT Guru can read, you must use one of the following 
identifiers.

For information about importing baseline loads, see Chapter 12 Importing 
Baseline Loads on page ITU-12-1 of the Guru User Guide.

Procedure 4-1   Creating MRTG Log Files

1 Specify the targets using one of the identifiers listed in Table 4-3. This ensures that 
the MRTG configuration file contains data in a form that IT Guru can import.

2 Verify that the log file names are in the correct format. By default, log file names 
have the format <mrtg_identifier>.log. For example, if you chose to identify 
MRTG targets using ip_if#, the log file name for one interface might be 
172.16.10.150.1.log.

Table 4-2 MRTG Link Loads: Pre-Import Checklist

Step When Required Reference

Specify aliases Once per scenario. Required for nodes 
or links that meet both these conditions:

• Were created manually 

• Are referenced by the imported data

Working with Aliases on 
page ITU-11-11

Create data files As needed. IT Guru cannot generate 
MRTG data files automatically.

Creating MRTG Link-Load 
Data on page MVI-4-2

End of Table 4-2

All data of
interest imported?

END

 Yes 

 No 

START

Prepare for import

Import data

Verify import Troubleshoot import

Table 4-3   MRTG Identifiers

MRTG Identifier Description Example

ip_if# IP address and interface number 172.16.10.150.1

ip_ifDescr IP address and interface description 172.16.10.150.Serial1_0

End of Table 4-3
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3 If an MRTG log file corresponds to a network object that was created manually, you 
must create aliases for the IP address and interface as described in Mapping 
MRTG Files to IT Guru Interfaces,

4 After you create data files and create aliases (if necessary), go to Preparing for a 
Baseline Load Import on page ITU-12-3 of the Guru User Guide.

End of Procedure 4-1

Mapping MRTG Files to IT Guru Interfaces

You must specify aliases for every object that meets both of these conditions:

• Has load data specified in an imported MRTG files

• Was created manually (that is, was not imported from device configuration 
files or an external program)

If these conditions are true for an object, you must specify aliases for both the 
IP address and the interface as specified in the MRTG log file name. Suppose 
you have an MRTG log file named 10.1.1.1.1.log. Your network must have 
aliases for both the IP address (IP: 10.1.1.1) and the interface number 
(IF:1). You can specify these aliases in either of the following ways:

• IP address and interface as aliases on the same link interface

• IP address as a node alias, and interface as an alias on the connected link 
interface

Table 4-4 lists the supported formats for MRTG aliases. For information about 
how to create node and interface aliases, see Working with Aliases on 
page ITU-11-11 of the Guru User Guide.

Table 4-4   Interface Aliases Used for MRTG Imports

Alias Format Specified As Example

IP:<node_name>

IP:<ip_number>

IP:<domain_name>

IP:<mrtg_log_file_name>

Node or interface alias IP:172.16.10.150

IP: wtn150.acme.com

IP: ita.acme.com

IP:ita.acme.com.2.log

IF:<interface_number> Interface alias IF:1

IFName:<interface_description> Interface alias IFName:Serial1/0

End of Table 4-4
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InfoVista Link Loads: Preparing for an Import

IT Guru can import link loads from InfoVista. Table 4-5 lists the steps to do 
before you import InfoVista data. After you do these steps, proceed to Importing 
Baseline Load Data on page ITU-12-9 of the Guru User Guide.

Installing the IT Guru Report Template

You must do this task once, before you define a report template and generate 
reports. This step is required to ensure that InfoVista generates reports in the 
correct format.

Procedure 4-2   Installing the IT Guru Report Template in InfoVista

1 If InfoVista and IT Guru are installed on different computers, copy the following IT 
Guru file to a directory on the InfoVista computer:

<reldir>/sys/etc/mvi_infovista_template_v2.ivl

2 In InfoVista, choose File > Install VistaViews.

➥ A directory browser opens and prompts you to select the VistaView source 
directory.

3 Select the directory where the mvi_infovista_template_v2.ivl file is located. (If you 
have IT Guru and InfoVista installed on the same computer, this file is located in 
<reldir>/sys/etc.)

➥ The “VistaView Installer” window opens.

Table 4-5 InfoVista Link Loads: Pre-Import Checklist

Step When Required Reference

Install OPNET 
report template

Once. Do this step first. Installing the IT Guru Report 
Template on page MVI-4-4

Define a new 
report

Once, after you install the template. Defining an InfoVista Report 
on page MVI-4-5

Create data files As needed. This step is required only if 
the OPNET computer cannot 
communicate with the InfoVista 
computer using telnet and ftp.

Creating InfoVista Data Files 
Manually on page MVI-4-7

Specify aliases Once per scenario. Required for nodes 
or links that meet both these conditions:

• Were created manually 

• Are referenced by the imported data

Working with Aliases on 
page ITU-11-11

End of Table 4-5

All data of
interest imported?

END

 Yes 

 No 

START

Prepare for import

Import data

Verify import Troubleshoot import
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Figure 4-1   “VistaView installer” Window

4 Select the VistaView named “OPNET Throughput” and click Install.

End of Procedure 4-2

Defining an InfoVista Report

You must do this task once, after you install the OPNET template (as described 
in Procedure 4-3). This report specifies the interfaces and links for which you 
want to collect data.

Procedure 4-3   Defining a New InfoVista Report

1 Ensure that the instances for SNMP include all the interfaces or IP addresses you 
want to poll:

1.1 In the main InfoVista window, click the General tab.

1.2 Expand the treeview so the following category is expanded:

Vistas ➘ SnmpNode ➘ Instances

1.3 If this category is missing any instances, Right-click on the “Instances” branch 
and choose Add Instance. Then enter the instance name and click OK. 

1.4 Repeat step 1.3 for each instance you want to add.

2 Choose Reports > Running.

➥ The Found Reports Running dialog box appears.

3 Choose Edit > Add Report.

➥ The “<report_name> Report” dialog box appears. 

4 Enter a report name in the Name field.
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5 Apply the OPNET template:

5.1 In the “<report_name> Report” dialog box, click the button next to the “Report 
Template” field:

➥ The Choose Report Templates dialog box appears.

5.2 Search on the string “*” (one asterisk) to find all available templates.

5.3 Select the “Opnet Traffic/Throughput” report template and click Add.

➥ The Choose Report Templates dialog box closes.

6 Add one or more instances to the report:

6.1 In the (unnamed) (Report) dialog box, click on the button next to the Instances 
field.

➥ The “Instances of <report_name>” dialog box appears.

6.2 Choose Edit > Add.

➥ The “Choose Instances to add” dialog box appears.

6.3 Search on the string “*” (one asterisk) to find all available instances.

6.4 Select the instance you want to add to the report, then click Add.

➥ The “Choose instances to add” dialog box closes and the instance is added 
to the report.

6.5 Repeat steps step 6.1through step 6.5 for each instance you want to add.

6.6 After you add all instances, click OK in the “Instances of <report_name>” 
dialog box.

7 In the “<report_name> (Report)” dialog box, verify that the State field is set to 
Running, then click OK

End of Procedure 4-3
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Creating InfoVista Data Files Manually

Required only if the OPNET computer cannot communicate with the InfoVista 
computer using telnet and ftp. Before you generate a report, you must complete 
Procedure 4-2 and Procedure 4-3. 

Procedure 4-4   Generating an InfoVista Data File

1 Make sure that you have collectors installed on all hosts for which you want to 
capture data. For more information, see the InfoVista documentation.

2 If the OPNET template is not installed, do Procedure 4-2 Installing the IT Guru 
Report Template in InfoVista on page MVI-4-4.

3 If there is no report (based on the OPNET template) defined, do 
Procedure 4-3 Defining a New InfoVista Report on page MVI-4-5.

4 Generate an InfoVista report:

4.1 Choose Reports > Running.

➥ The Found Reports Running dialog box opens.

4.2 Double-click on the report you want to generate.

➥ The “<report_name> Report” widow opens and shows the data collected.

5 Export your report data to one or more text files: 

5.1 In the Report window, choose Report > Export. 

5.2 Choose Data (text) format. This is the data file that you will import into IT Guru.

6 After you create data files, go to Preparing for a Baseline Load Import on 
page ITU-12-3 of the Guru User Guide.

End of Procedure 4-4
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Performance Insight Link Loads: Preparing for an Import

IT Guru can import link loads from HP OpenView Performance Insight. 
Table 4-6 lists the steps to do before you import Performance Insight data. After 
you do these steps, proceed to Importing Baseline Load Data on page ITU-12-9 
of the Guru User Guide.

Configuring Performance Insight

To configure Performance Insight, you must install the 
IR_OPNET_Export_Datapipe package. You can install this package from the 
Performance Insight CD or download it from the HP website. 

After you install the OPNET reporting package, configure Performance Insight 
to generate OPNET reports using this package. For more information, see the 
Performance Insight documentation. 

Table 4-6 HP OV Performance Insight Link Loads: Pre-Import Checklist

Step When Required Reference

Install the OPNET 
package

Configure PI to 
generate data files

Once. Do these steps first. Configuring Performance 
Insight on page MVI-4-8

Move data files to 
OPNET computer

As needed. This step is required only 
if the OPNET computer cannot 
communicate with the Performance 
Insight computer using telnet and ftp.

Specify aliases Once per scenario. Required for 
nodes or links that meet both these 
conditions:

• Were created manually 

• Are referenced by the imported 
data

Working with Aliases on 
page ITU-11-11

End of Table 4-6

All data of
interest imported?

END

 Yes 

 No 

START

Prepare for import

Import data

Verify import Troubleshoot import
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Concord eHealth Baseline Loads: Preparing for an Import

IT Guru can import link loads from Concord eHealth. Table 4-7 lists the steps to 
perform before you import Concord eHealth data. When finished, proceed to 
Importing Baseline Load Data on page ITU-12-9 of the Guru User Guide.

Note—This section describes how to generate IT Guru-compatible data files in 
Concord eHealth-Network version 5.0 (on Solaris) and version 5.6 (on 
Windows). Procedures might differ for other versions of eHealth-Network. To 
see if your version is supported by IT Guru, go to http://www.opnet.com/support 
and follow the “System Requirements” link.

Creating CeH Object Groups

You must do this task if both of these conditions are true:

• You want to collect data for some (not all) objects in your network 

• You have not yet created an object group, or you want to group a new set of 
objects

All data of
interest imported?

END

 Yes 

 No 

START

Prepare for import

Import data

Verify import Troubleshoot import

Table 4-7 Concord eHealth Baseline Loads: Pre-Import Checklist

Step When Required Reference

Create one or more 
object groups

This step is required if you want to collect on a subset of objects and 
do not have an object group defined. If you want to collect data on 
all objects, this step is optional.

Creating CeH Object Groups 
on page MVI-4-9

Create a Concord 
alias file

Required if you have objects in your network that are not 
referenced by a CeH alias file.

Creating a CeH Alias File on 
page MVI-4-11

Create data files

Move data files to 
OPNET computer

As needed. These steps are required only if the OPNET computer 
cannot communicate with the Concord eHealth computer using 
telnet and ftp.

Creating CeH Data Files on 
page MVI-4-12

Specify node and/or 
interface aliases

Once per scenario. Required for nodes or links that meet both 
these conditions:

• Were created manually 

• Are referenced by the imported data

Working with Aliases on 
page ITU-11-11

End of Table 4-7
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An object group is a collection of Concord objects for which you want to collect 
data. If you have objects of interest collected in groups, you can specify group 
names when you create alias and data files. This limits file sizes and speeds up 
data-collection and import times, because Concord excludes irrelevant data.

Procedure 4-5   Creating an Object Group in Concord eHealth

1 Log in to the eHealth–Network system.

2 From the main Concord eHealth window, choose Reports > Edit Groups > 
LanWan Groups.

➥ The LAN/WAN Groups dialog box opens.

3 Click Add.

➥ The Add LAN/WAN Groups dialog box opens.

4 To add an interface to the group:
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4.1 Under Available Elements, click LAN Interface or WAN Interface.

➥ The interface list shows all polled interfaces of the specified type.

4.2 To add an interface to the group, select it in the list and click the left-arrow 
button.

➥ The interface appears in the Group Members list.

5 When the group includes all interfaces for which you want to collect data, enter a 
name in the Group Name field.

6 Click OK to close the Modify LAN/WAN Groups dialog box, then click Close to 
close the LAN/WAN Groups dialog box.

End of Procedure 4-5

Creating a CeH Alias File

You must do this task if:

• You have not yet created an alias file

• You have an alias file, but it does not include objects of interest

You must generate a file that contains the CeH aliases of all objects for which 
you want to import data. A CeH alias is a name assigned by CeH, which can be 
different from the name obtained while querying the device using SNMP. You 
must include this file (along with the Concord data files) the first time you import 
from Concord into IT Guru. 

An ideal alias file contains only aliases for objects of interest. There are a 
number of arguments that allow you to limit the contents of the alias file. For 
example, you can define a group for a subset of objects and then output the 
aliases for this group; for more information, see Procedure 4-5 Creating an 
Object Group in Concord eHealth on page MVI-4-10.
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Make sure that you export all aliases for the objects of interest. If the network is 
large, this command might take some time to complete. If you specify 
arguments that limit the output set of aliases, you can reduce the execution time 
for this command.

The “nhExportConfig” command is used to generate alias files. Use the 
command “nhExportConfig –help” and study the various options available. 
Refer to CNH documentation for more information about this command.

The alias file should have an extension *.dco. When you specify the output 
filename as the argument, make sure that you append the extension. 
Otherwise, you can modify the filename to include the extension after it has 
been generated.

Note—The alias file is the key to the link-load data that is imported into IT Guru. 
If you import load data for an object for which there is no alias, IT Guru will not 
import that data.

Procedure 4-6   Creating an eHealth-Network Alias File

1 Log in to the eHealth–Network system.

2 Generate the config (.dco) file by typing the following command:

nhExportConfig -dciOut <file_name>.dco

Note—You might want to include additional command-line arguments to limit the 
number of objects included in the alias file.

3 If Concord and IT Guru are running on different computers, copy the .dco file to 
your IT Guru computer.

End of Procedure 4-6

Creating CeH Data Files

This step is optional. By default, generates data files automatically whenever 
you do an import. 

The “nhExportData” command is used to generate a file that contains load data. 
By default, this command exports all traffic generated by the polled objects. 
Therefore, this file might be very large depending on the number of objects and 
the poll rate. You can reduce the length of this file by eliminating objects for 
which you do not want to export traffic. You can create a group that contains 
only the objects of interest and specify this group as an argument (for more 
information, see Procedure 4-5 on page MVI-4-10.) Use the “nhExportData 
–help” command to obtain a list of the arguments and refer to the CNH 
documentation for instructions on using them.
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By default, Concord exports all traffic generated by all polled objects. Because 
this can result in very large data files, it is good practice to collect data for 
objects of interest only.

If the files are large, you can distribute traffic information into multiple files by 
distributing devices into different groups. You can import multiple traffic files in 
a single operation within IT Guru. 

The data file should have an extension *.dci. When you specify the output 
filename as the argument, be sure to append the extension. Otherwise, modify 
the filename to include the extension after it has been generated.

Procedure 4-7   Creating an eHealth-Network Data File

1 Log in to the eHealth–Network system.

2 Generate the data files that contain the utilization data for the objects of interest. 
These are standard-format eHealth–Network data (.dci) files. You can generate a 
data file for a single eHealth–Network object, a group of objects, or all polled 
objects using the nhExportData command. Enter the nhExportData -help 
command to obtain a list of the available arguments and refer to the CNH 
documentation for information about their use. 

CAUTION—A data file for all polled objects might be very large depending on the 
number of objects and the poll rate. For this reason, it is good practice to create data 
files only for objects of interest. 

You can generate a data file for a single object or group of objects by entering the 
following command:

nhExportData -subjName <name> -fromDate mm/dd/yyyy -fromTime 
hh:mm:ss -toDate mm/dd/yyyy -toTime hh:mm:ss -subjType 
<subject_type> -techType <technology_type> -vars <variable> -outFile 
<file_name>.dci

where

• <name> is the name of a single element or group of objects for which to extract 
data. For more information about Concord object groups, see Creating CeH 
Object Groups on page MVI-4-9.

• <subject_type> is element if the subjName argument specifies one 
element, or group if the subjName argument specifies a group of elements

• <technology_type> is lanWan for links and server for servers

• <variable> can be one of the following:

• bitsIn or bitsOut for links

• bandwidthIn or bandwidthOut for links (CeH version 5.6 on Windows)

• bandwidthIn, bandwidthOut, or ”bandwidthIn,bandwidthOut” 
for links (CeH version 5.0.2 on Solaris)

• CpuUtilization for servers
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For more information about the other fields, type nhExportData -help.

3 If Concord and IT Guru are running on different computers, copy the .dco file to 
your IT Guru computer.

4 After you create data files, go to Preparing for a Baseline Load Import on 
page ITU-12-3 of the Guru User Guide.

End of Procedure 4-7
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App A Additional DCI Procedures

This appendix contains procedures and flowcharts related to using Device 
Configuration Import (DCI) as part of the Multi Vendor Import (MVI) module.

Determining Cisco Device Type

The following flowchart describes the way in which DCI determines the validity 
of a file to be imported and the type of Cisco device from which it was taken— 
router, switch, or PIX firewall. In this way, Modeler can match the configuration 
file to the correct node type.

Figure A-1   How DCI Determines the File Type of Cisco Configuration Files
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Figure A-2   How DCI Determines the Type of Cisco IOS File

Creating Configuration Files for DCI

This section of the appendix describes the procedures for capturing the devices 
files to be imported with DCI. 

Procedure A-1   Creating Configuration Files for Cisco Devices (excluding 
Catalyst Switches)

1 Log in to the device for which you want to create a configuration file.

2 Enter the following command at the login prompt to disable pauses for page breaks 
in output:terminal length 0.

➥ The command will not pause after a given number of line or include “--more--” 
in the show command output.

3 Create a new text file in any text editor. Make sure that text wrapping is not 
enabled.

4 Enter the following command at the prompt (and your password, if applicable): 
enable

➥ The command prompt changes to a number sign (#).

5 Enter the following command at the prompt: show running-config
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6 Paste the output of the command in step 5 to the text file.

7 Repeat step 5 and step 6 for the following commands. 

• show version

• show frame-relay map

• show atm map

• show cdp neighbors detail

• show vlan

Note—This step is optional for PIX devices and routers running IOS. The 
information from the show version command helps DCI match the device type. The 
information from the show cdp neighbors detail command helps DCI identify 
neighbors for switch port connectivity or when there are unnumbered interfaces. 
The static mapping information from the show atm map and show frame-relay map 
commands is needed for the importing of actual PVC topology, rather than the 
creation of a full-mesh of PVCs.

➥ You should now have a text file that consists of the output of all five commands. 
Make sure that the output from the show running-config command appears 
before the output of any other commands.

8 Save the text file. This is the configuration file that DCI needs to import information 
about the router.

9 Log out of the router.

End of Procedure A-1

Procedure A-2   Creating Configuration Files for Cisco Catalyst Switches 
(Running CatOS)

1 Log in to the switch for which you want to create a configuration file.
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2 Enter the following command at the login prompt to disable pauses for page breaks 
in output:set length 0.

➥ The command will not pause after a given number of line or include “--more--” 
in the show command output.

3 Create a new text file in any text editor. Make sure that text wrapping is not 
enabled.

4 Enter the following command at the prompt (and your password, if applicable): 
enable

➥ “(enable)” appears in the command prompt.

5 Enter the following command at the prompt: show config all

6 Paste the output of the command in step 5 to the text file.

Figure A-3   Creating a Configuration File for a Cisco Switch

7 Enter the following command at the prompt: show cdp neighbors detail. DCI 
needs the output of this command to establish layer-2 connectivity.

8 Paste the output of the command in step 7 to the text file.

9 Save the text file. This is the configuration file that DCI needs to import information 
about the switch.

10 Log out of the switch.

End of Procedure A-2

Procedure A-3   Creating Configuration Files for Juniper Routers

1 Log in to the router for which you want to create a configuration file.

2 Create a new text file in any text editor. Make sure that text wrapping is not 
enabled.
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3 Enter the following command at the prompt: show configuration

4 Paste the output of the command in step 3 to the text file.

Figure A-4   Creating a Configuration File for a Juniper Router

5 Enter the following command at the prompt: show version

6 Paste the output of the command in step 5 to the text file.

7 Save the text file. This is the configuration file that DCI needs to import information 
about the router. 

8 Log out of the router.

End of Procedure A-3

Setting Import Preferences

Procedure A-4   Setting Import Preference for Layer-3 Devices Only

1 Choose Edit > Preferences. 

2 Type ‘device’ into the Find input area at the top of the dialog, and click on the Find 
button. You will see a list of device_import options.

3 Look for the option named ‘device_import.layer3_only_import’, and change the 
value from FALSE to TRUE. Click OK.

Note—The default value for this preference is FALSE, permitting import of 
all device types. To enable the importing of Layer-3 devices only, set the 
value to TRUE. You must restart IT Guru for the change to become effective

4 Quit and restart OPNET to enact the change.

Note—You can also edit preferences by opening the env_db file in a text editor.
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Procedure A-5   Setting Import Preference to Allow Partial Import

1 Choose Edit > Preferences. 

2 Type ‘device’ into the Find input area at the top of the dialog, and click on the Find 
button. You will see a list of device_import options.

3 Look for the option named ‘device_import.skip_partial_devices’, and change the 
value from FALSE to TRUE. Click OK.

Note—The default value for this preference is FALSE, permitting import of 
partial devices. To skip importing partial devices, set the value to TRUE. 
You must restart IT Guru for the change to become effective.

4 Quit and restart OPNET to enact the change.

Note—You can also edit preferences by opening the env_db file in a text editor.

End of Procedure A-5

Procedure A-6   Disable Import Preference to Infer Layer-3 IP Tunnel Cloud

1 Choose Edit > Preferences.

2 Type ‘device’ into the Find input area at the top of the dialog, and click on the Find 
button. You will see a list of device_import options.

3 Look for the option named ‘device_import.tunnel_cloud_import’, and change the 
value from TRUE to FALSE. Click OK.

Note—The default value for this preference is TRUE, permitting OPNET to 
infer Layer-3 IP clouds from IP tunnel configurations when there is no 
Layer-2 connectivity. To disable the inference of Layer-3 IP tunnel clouds, 
set the value to FALSE. You must restart IT Guru for the change to become 
effective.

4 Quit and restart OPNET to enact the change.

Note—You can also edit preferences by opening the env_db file in a text editor.

End of Procedure A-6
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